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Introduction of kymograph

* A 2D plot of time versus space created from time-lapse images

(videos)
* Display actual velocity of the time-lapse

e Usually used for microtubule movement, heartbeat, etc (observing

motility)



The analysis pipeline of this study

Image process

Information extraction

Obtainable Parameters

Video tapping @ 200 fps for
heartbeat

Use Kymograph plugin in Imagel
to analyze cardiac rhythm

Video format conversion
to avi format

Result plotting, smoothening,
and interval detection in Image)
using BAR Plugin

Video stabilization using Image
Stabilizer plugin (optional)

Data calculation using Microsoft
Excel 2016

Zebrafish

A — —— 2 T
" g

Daphnia

* Heartrate

* Heartbeat interval

* Fractional Shortening
* Ejection Fraction

e Stroke Volume

e Cardiac Output

* Heartbeat regularity




Video recording

* Video recording was done using high speed CCD

* Video recording that can be used for kymograph can be obtained
from inverted microscope using HiBestViewer Application (AZ

Instrument, Taiwan)



Video Recording using HiBestViewer Application
(AZ Instrument, Taiwan)

85 HiBestViewer - 1.0.6.1

File View Help
Acquire View  Strip View Waorking View

it | 11 ® | P

Received Frame Number : 54660, Spent Time : 273.27, Received Frame Rate : 200.02
Processed Frame Number : 54660, Spent Time : 273.27, Display Frame Rate : 25.06

Ready

Camera Settings

@ Exposure Time: | 500 us

Gain: |1

Record Settings

3 Auto Shot Speed

(Set O fps to disable "Auto Shot Spee

£

Model Type: |HSU3-M1300P-

1 Resolution: 1280 %1024 ~

£

00| fps

Max Frames : 43806
4] Record Frames : 2000
Record Time : ~10.0| sec

Trigger Settings
0 50
Trigger Percentage : 20
Pre-trigger frames: 400
Time: ~2.0
Post-trigger frames : 1600
Time: ~8.0
Preview

1.

Resolution : Size of the video taken with a
linear correlation to sharpness and clarity.

Exposure time : duration of time in which
the sensor within the camera exposed to light

Auto Shot Speed : number of frames taken in
one second for the recording (fps)

Record Frame : Number of frame set
manually by the user to determine the
recording length. The final duration of the
video is presented in Record Time. This
number cannot exceed the Max Frames or 0.

Preview : Start viewing the current condition
of the object of interest under the
microscope.

Trigger : Start recording after preview

Stop : Stop the recording or the viewing.



Video conversion using VirtualDub

.mp4 video must be converted to .avi to be recognized by Image)

@ VirtualDub 1.10.4 (build 35491/ release-AMDE4) by Avery Lee
Edit View  Go_ Videgfudi

File

abia el oale Hel

< Open video file...

Reopen video file

Append AVl segment...
Preview input...

Preview filtered..,

Preview output from start...
Run video analysis pass
Save as AVl...

Save old format AV...

Save segmented AV...

Close video file

Export

Queue batch operation
File Information...

Set text information...

Sawe WAV...

Load processing settings...

Save processing settings...

Start frame server...
Capture AVL...
Run script...

Job control...

1 GG Ky ot 20200228 LPlan20x -Temnp 35 -7 Slowed down.mpd

2 CA\LAFUGLUNDeskto p\Kym o\ 20200228 LPlan20x - Temp 15 - 7.avi

3 Ch\Users\FUGU\Desktop\Kymo\shrimp4d_front part.avi

4 CA\Users\FUGU\Desktop\Kymo\20200228 LPlan20x -Ternp 35 -4.avi

Quit

ey =

Select a file for processing.

2m

Shift+F7

Crl+W

Ctrl+L
Ctrl+5

F4

[

@ VirtualDub 1.10.4 - [20200228 LPlan20x - Ternp 35 -7 Fast Beat.avi]

File

Edit View Go Video
Open video file...

Reopen video file
Append AVl segment...
Preview input...

Preview filtered...

Preview ocutput from start...

Audic

Options

Tools

Help

Ctrl+0
F2

Space
Enter
F5

Run »

< Save as AVI...

Save old format At
Save segmented AVl...

Close video file

Export

Queue batch operation
File Information...

Set text information...
Save WAV...

Load processing settings...

Save processing settings...

Start frame server..,
Capture AVI...
Run script...

Job control...

1 G\ AKymo)\ 20200228 LPlan20x -Temp 35 -7 Fast Beat.avi

2 G\ A\Kymo\20200228 LPlan20kx -Ternp 35 -7 Slowed down.mpd
3 CALAFUGWAD esktop\Kym 0\20200228 LPlan20x -Termp 13 - 7.avi
4 C:A\Users\FUGU\Desktop\Kymao\shrimp4_front part.avi

Quit

B =

Render output to an AVI file.

Shift+F7

Ctrl+W

Ctrl+L
Ctrl+5

F4

1 | ] 1 | 1 1 ] |
160 170 180 130 200 210 220 230 239




Outline

* Kymograph generation using Imagel m and Zebrafish Heartbeat
* Image Stabilizer (Optional)

* Data Collection using BAR Plugin

e Data Calculation in Microsoft Excel

* Included macro



Kymograph creation

Manually determine and draw a line from the center to the outermost
location of Region of Interest (ROI).
(We use zebrafish heart as the ROI for this example)

[ {Fiji Is Just) Imagel —_ 0 %
File Edit Image_ Process Analyze Plugins Window Help
Ojo|c|ofF £ [\ A| |0 ofseju]s|s|a] |-

*Straight”®, segmented or freehand lines, or arrows (nght click to switch)  Click here to search




* Use Dynamic Reslice (Image > Stacks > Dynamic Reslice > Rotate 90

degrees) to create Kymograph

[T (Fiji Is Just) Image)

Process Analyze Plugins Window Help

m] bes

File Edit

1Qloja Twe >

Polygon sele; Adjust »
Show Info._ Ctri+l
Properties... Ctrl+Shift+P
Color r

J Dmv‘s.u_|wl‘p‘|j|&‘ |>>'

Hyperstacks *| Delete Slice
Crop Ctri+shiftsx | Next Slice [7]
Duplicate... Cut+shifep | Frevious Slice [<]
Renarme... Set Slice
Scale.. Ctri+E Images to Stack
Transform ¥+ Stack to Images
Zoom *| Make Montage...
QOverlay * Reslice [/]...
L ookup Tables ,| Orthogonal Views
Z Project...
bLEE 3D Project...
TEmTE *| Plot Z axis Profile
VST ET Measure Stack...
Axes v Label
Convert Statistics
Convolve Animation
Threshold *| Tools

Cirl+Shift+H

Radial Reslice

Dynamic Reslice

Series Labeler

Time Stamper
Reslice Z
| View5D

Kalman Stack Filter

Resulting Kymograph

»
»

A AANRAARNARMAAARRANIAL

—— Time (Frame)

—> Space



Result example

Atrium Time

Space

Ventricle
Space

Time: Frame of the Video
Space: Distance of the Line



Editing
Resulting kymograph image contrast can be edited by using
Brightness/Contrast (Image > Adjust > Br:ghtness/Contrast)

[57 (Fiji Is Just) Imagel

File EdrtProcess Analyze Plugins Window Help

Sjola e 2 o] 2] 4] 0] |»
Magnifying gl s BT e Cirl+Shift+C
Show Info_.. Ctri+l | Window/Level...
Properties. .. Ctri+Shift+P | Color Balance. ..
Color ¥\ Threshold... Ctrl+Shift+T
Stacks *| Color Threshold...
Hyperstacks v Size .
Crop Ctrl+Shift+X j @B&C X
Duplicate . Ctri+Shift+D |
‘ Rename... 2 -
Scale... Ctr+E | Al
Transform A
Zoom + Bl
Overlay A g S
Lookup Tables y A LLI Minimum —’I -
Annotate 4 SC{ L[ I’I -
Drawing v Maximum
Video Editing 4 I I ’I
Axes Brightness
Convert —l‘ I—’I
Contrast
COnVOlVe ................................
Threshold { Auto | Reset
Set Apply




Editing cont.
Or by using Find Edges (Process > Find Edges)

[5% (Fiji Is Just) Image) — O x
File Edit ImageAnaIyze Plugins Window Help

Qggﬂ: Smooth cuishitss |wt| §| 4 || |»
*Multi-point® or point (r  Sharpen Click here to search
Find Maxima...

Enhance Contrast...

B A :

Filters »

Batch 4
Image Calculator...

Subtract Background...

Repeat Command Ctri+Shift+R

Calculator Plus

Morphology 4
Image Expression Parser

Image Expression Parser (Macro)
Multiple Image Processor

Enhance Local Contrast (CLAHE)




Edited Result example

Atrium Time

—>

Bt

Time: Frame of the Video
Space: Distance of the Line




Image Stabilizer

* Image Stabilizer plugin is used for stabilizing ROl movement in the
video.

* This process is optional as not all video has moving ROI that might
interfere with the data collection.

* The Image was processed using Lucas-Kanade Algorithm

* The plugin can be downloaded from
http://www.cs.cmu.edu/~kangli/code/Image Stabilizer.html!

K. Li, "The image stabilizer plugin for Imagel," http://www.cs.cmu.edu/~kangli/code/Image_Stabilizer.html,
February, 2008.


http://www.cs.cmu.edu/~kangli/code/Image_Stabilizer.html

Image Stabilizer

* Open the video in ImagelJ without ticking the Virtual Stack box in
order to keep the video for use.

|| AVI Reader b

First Frame: |1

Last Frame: |2000

| Convertto Grayscale
| Flip Vertical

OK | Eann::el|




Image Stabilizer

* Run the Image Stabilizer
Plugin (Plugins > Image
Stabilizer).

* Move the video slider to
the middle of the video
duration, because the
algorithm will stabilize the
video using the selected
frame as a template.

mEln s mamen maln name namn sl sous [4° (Fiji Is Just) Image)
File Edit Image Process Analyze ActogramJ

EQ’G’QD’/I&‘#‘" ‘\‘A‘O\N“] Analyze

| 1/2000 (0.03 s); 1280x1024 pixels; RGB; 9.86B

;b_ﬂ_]

3D Viewer

(Fiji Is Just) ImageJ 2.0.0-rc-69/1.53c; Java 1.8.0_172 [6{ BestEdges

BigDataViewer
Bio-Formats
Cluster

Color Inspector 3D
Debayer
Examples

FITS

FWHM

Feature Extraction

FeatureJ

-1 HDF5

Image Stabilizer

Image Stabilizer Log Applier
ImagesD

Integral Image Filters
Janelia H265 Reader
LOCI

LSM Toolbox

LUT

Landmarks

MTrackJ
MultipleKymograph
MultipleOverlay
Multiview Reconstruction




Image Stabilizer

* Popup window will open for Image Stabilizer settings. However we
usually just left the settings as is, then click OK.

* Then wait for the stabilizing process to finish.

e Stabilizing process can be repeated until desired condition is reached.

[£:| Image Stabilizer X

Transformation: [JEELEEINGE ~

Maximum Pyramid Levels: |1 = (Fiji Is Just) Imagel - O X
Template Update Coefficient (0.1): [0.90 File Edit Image Process Analyze FPlugins Window Help BAR OD

Maximum lterations: 200 - D, D, GJ_@ A A -ﬂ - Stkv UJTv‘ 4 ‘ 4 ‘ 5 ‘ ‘:*}
Error Tolerance: |0.0000001 5tabilizing 587/2000 ___ (Press 'ESC’ to Cancel) ]

[ Log Transformation Coefficients

[ Output to a Mew Stack
Cancel | |




Image Stabilizer
Result

Before After




Data Collection Using BAR Plugin

We can obtain ROl data peaks from the kymograph by making a line
followed by the Plot Profile Command (Ctrl + K)




Caution

* Specified line is subjective, it might show unsuitable result

[F Dynamic Reslice of ControlLPlan 4 - o X [ Dynamic Reslice of ControlLPlan10x40) - O X
2000x171 pixels; RGB; 1.3MB 2000x171 pixels; RGB; 1.3M8

[T Plot of Dynamic Reslice of ControlLPlan10x40min - [m] X [ Plot of Dynamic Reslice of ControlLPlan10xd0min - o X
2104.21x113.41 (1400x534); B bit; 730K 2104.21x110.00 (1400x534); 8-hit; 730K
. T T T T
160 -
160 H -
1o i
1 i
0
H 3
§ v
H H
] |
100 |-
™
wl
Il 1 Il L L L 1 L L 80 1 1 1 1 1 1 L L 1 3
o 200 0 a00 a0 000 1200 1400 000 000 o 200 @0 w00 w00 000 1200 a0 o0 a0
Disance (lsel) Diance (lsel)
List Data= | Morea | Live | X=840, ¥(X)=77 List | Datas | Mores | Live [ X=1309, Y(X)=11%

Not Suitable Suitable



Data Collection Using BAR Plugin

Smoothed Plot

* The unsuitable reading can be adjusted by using Smoothed Plot
Profile tool (BAR > Analysis > Smoothed Plot Profile)

[4 Dynamic Reslice of ContrelLPlan10x40min (73%

0 200
List | Datax | More s ﬂl

Blue Line = Raw Plot
Red Line = Smoothed Plot Profile



Data Collection Using BAR Plugin
Smoothed Plot

* To use the Smoothed Plot for the next step, we made a macro to
create a new standalone plot based on the smoothed plot, otherwise
BAR Plugin will rather use the Raw Plot for Detection.

! » )-WU
l
i ‘|
M

|

Y 1

.
|

——
o
—
g
——

0 200 400 &00 800 1000 1200 1400 1800 1800 0
Distanee (pixels)
List | Datas | Mores| Live List | Datas | More»




Data Collection Using BAR Plugin

* To obtain the Peak data, we use the Find Peaks tool (BAR > Data
Analysis > Find Peaks) provided by BAR Plugin.

(FijiIs Just) - a ped
File Edit Ima: Process ze Plugins Window Help JEl3q OD
E||O‘G‘@/L|+‘§\‘A‘O\|dm}|.‘ De\r‘ ‘ Analyms r
Pencil Tool ation +

Interactive Plotting...

Create Boxplot
Create Polar Plot
Distribution Plotter
Fit Polynomial My Routines
NN Distances

o 200 o
List | Datas | Mores | X=1053, Y(X)=134.75



Data Collection Using BAR Plugin

* Afterwards, a window will pop
up. This window is used to set
the parameter for the peaks.

|£: Find Local Maxima/Minima... >

1 Min. peak amplitude:

2 Min. peak distance: |0.00

3Min. value of maxima: (MaM: no filtering)
AMax value of minima: (MaM: no filtering)

5 [ Exclude peaks on edges of plot
6 [ Listvalues

QK | Cancel| Help|

Min peak amplitude value is set automatically by
the plugin at first. For zebrafish however, we
usually adjust it to double or triple the automatic
value, as there is a lot of short peaks.

1. Min. peak amplitude : Minimal amplitude of
the peak to be considered as a peak, otherwise
it will not be recorded

2. Min. peak distance : Minimal distance
between peaks to be considered as peaks

3. Min. value of the maxima : Minimal value of
the peak to be considered as the maxima

4. Max. value of the minima : Maximal value of
the peak to be considered as the minima

5. Exclude peaks on edges of the plot : Exclude
the peaks on the edges as it might be
premature, thus messing up with the data.

6. List values : Automatically list all the data.

We usually adjust the Min. peak amplitude and
check the box for the exclude peaks and list
values, while leaving other options empty unless
there are some necessary alteration. Then press
OK



Data Collection Using BAR Plugin

* Final result of the BAR Plugin will mark the maxima and minima of the
plot. However, as can be seen below, either the maxima or minima
will have a fuzzy result, therefore only the maxima can be used for
this example

ooooooooooooooooooo

o 200
List Data = | More » | ¥=252, ¥=148.28




Data Collection Using BAR Plugin

* Then we get the values from the plot.

. P'i‘:_'“; - box * Black rectangle represents the value (YO)
ile Edit Font . . L.

SEE I 2 V2 | | on each points of time (X0) within the

0 1255000201 1535000 1693 786250 lot

1 1268000l 1526250 1216 76.7500 plo

2 1330000105 1522900 Q1566 793750 * Red rectangle represents the time where
3 13g4zeeffs62 1518750 951 60.0000 )

4 1420000381 1506250 1509 B5.7500 the maxima happens (Xl) and the value
5 1495000467 150.0000 636 66.2500 .

6 1476260296 1495000 1883 866250 of the maxima (Y1)

7 1520500775 14@s000 fl2se 67 6250 :

I e [t S * Blue rectangle represents the time where
3 1526280967 1458750 743 89 1250 minima happens (XZ) and the value of

10 14s0000 677 145a750 550 89 1250 ..

11 14450000870 1451250 f§831  90.3750 the minima (YZ)

12 14012601253 144 3750 1017 90 6250

13 13525001158 1425000 1423 91.3750

14 131.5000 9 1444 141 7500 @1301 92.0000 The Value is Sorted accordlng to XO

15 12850001348 1411250 1123 92,0000 ' ' |

16 12750001637 1401250 fl87  93.6250 To calculate time difference between beats,
17 12726001541 139 7500 f4s4 938750 .

O (O - we need to sort the data according to X1 or

- |4

-

X2 using Microsoft excel. Copy the data
using Ctrl + A then Ctrl + C.



X0

Data Calculation in Microsoft Excel

Sort the maxima (X1) data from the lowest to highest, then copy the

A

L = = I I T

AR A A R R i~
= O W0t o~ o [T TR =

B
Y0

125.5
126.8
133
138.4286
142
145.5
147.625
152.25
152.25
152.625
149
144.5
140.125
135.25
131.5
128.5
127.5
127.25
126.75
126
125
125.25

C

X1

201

105
382
391
487
296
773
1062
967
677
870
1253
1158
1444
1348
1637

1734
1927
1830

D
Y1

153.5
152.625
152.25
151.875
150.625
150
145.5
148.5
145.875
145.875
145.875
145.125
144.375
142.5
141.75
141.125
140.125
139.75
139.375
138.875
138.875

A

x2

E

1693
1216
1596
351
1509
636
1883
258
1378
743
350
831
1017
1423
1301
1123
87
454
1812
164
934

Y2

values for calculation in the next slide.

F
&

78.625
78.75

79.375 A
80 Z'Y p

85.75 Sort & Find &

86.25  Filter = Select -

86.625 ti £| Sort Smallest to Largest
87.625
88.75
89.125
89.125
90.375 0 Tell me more

Sign in R_Share

. 1 )

Sort Smallest to Largest

]

Lowest to highest.

|

90.625 ~ =T 1

91.375
92

92
93.625
93.875
95.125
101.375
102.25

X0

1
2
0
5]
4
]
3

10

7
11

9

8
13
12
15
14
17
16
18
20
19

Y0

145.5
138.4286
145
152.25
144.5
152.625
152.25
135.25
140.125
128.5
131.5
127.25
127.5
126.75
125

126

| X1 _l"r’l

9
105
201
296
391
487
582
677
773
a870
967

1062
1158
12533
1348
1444
1541
1637
1734
1830
1327

152.625
152.25
153.5
145.5
150.625
150
151.875
145.875
148.5
145.125
145.875
145.875
142.5
144,375
141.125
141.75
139.75
140.125
139.375
138.875
138.875

x2

1216
1596
1693
1883
1509
636
351
350
258
831
743
1378
1423
1017
1123
1301
454
a7
1312
934
164

Y2

78.75
79.375
78.625
86.625

85.75

86.25

a0
89.125
87.625
90.375
89.125

88.75
91.375
90.625

92

92
93.875
93.625
95.125
102.25
101.375



Data Calculation in Microsoft Excel

A B C D E F G H | J
} ) } : ) } Average Average
Atrium Ventricle Atrium Interval Ventricle Interval A-V Interval V-A Interval Atrium heartrate Ventricle heart rate

1 A-V Interval V-A Interval
2 66 105 0.465 0.48 0.195 0.27 125.5506608 125.1372119 0.20210526 0.27578547
3 159 201 0.49 0.475 0.21 0.28

4 257 296 0.47 0.475 0.195 0.275

5 331 391 0.485 0.48 0.2 0.285

6 LS 437 0.485 0.475 0.195 0.29

7 545 582 0.46 0.475 0.185 0.275

a8 637 677 0.475 0.48 0.2 0.275

g 732 773 0.495 0.485 0.205 0.29 | )
10 831 870 0.485 0.485 0.195 0.29

11 928 967 0.465 0.475 0.195 0.27

12 1021 1062 0.485 0.48 0.205 0.28

13 1118 1158 0.475 0.475 0.2 0.275

14 1213 1253 0.47 0.475 0.2 0.27

15 1307 1348 0.47 0.48 0.205 0.265

16 1401 1444 0.49 0.485 0.215 0.275

17 1499 1541 0.485 0.48 0.21 0.275

18 1596 1637 0.475 0.485 0.205 0.27

14 1691 1734 0.485 0.48 0.215 0.27

20 1788 1830 0.47 0.485 0.21 0.26

21 1882 1927
A. Peaks obtained in Atrium

B. Peaks obtained in Ventricle

Cand D. Interval between peaks in Atrium and Ventricle respectively in seconds
Equation : Peak,,,-Peak /200 (video is 200 fps)

E. Interval from Atrium peaks to Ventricle peaks

F. Interval from Ventricle peaks to Atrium peaks

E and F are used for determining pumping regularity between chamber



Other Data Collection

* Collection of data according to below slides to calculate ejection
fraction, shortening fraction, stroke volume, and cardiac output



Other Data Collection

Ventricular short axis Ventricular long axis



Other Data Collection

Ventricular short axis Kymograph
End Systolic Diameter 1 (ESD 1)

Systolic Interval (SI)
Ventricular long axis Kymograph

End Systolic Diameter 2 (ESD 2)

I




Other Data Collection

* End Diastolic Diameter (EDD) and End Systolic Diameter (ESD) data (1
& 2) can be obtained by manually measuring the length of the heart
when it is at the biggest and the smallest on both the short- and long-
axis. In addition, it is necessary to set the scale to obtain the data in
desired unit using calibration scale.

e Diastolic interval (Dl), Systolic interval (SI), and Heart period (HP) can
be obtained by measuring the heart when they are full of blood,
empty of blood, and the interval between beat respectively. This
measurement can be done by measuring horizontally such as
depicted in the last slide. The unit for this measurement is frame and
can be converted to seconds or minutes according to the refresh rate
of the recording equipment.




Set Scale

. . [ (Fiji I= Just) Image! - o
* Thls Step IS necessary to File Edit Image Process Plugins Window Help BAR OD
automatically convert length Ojo| |l <|+TXTA|a|m@| >jsu/s|s]a] |»
. . Wand (tracing) tool
unit from pixel to mm or cm |
during measurement process S I x| | Catorate
Distance in pixels: |17 HISthram Ctrl+H
* The Set Scale menu can be o Plot Profile  Ctri+K

Pixel aspect ratio: |1.U

accessed from Analyze > Set g — TR |
Scale e g .

Scale: <no scale>

e The calibration scale is a
circular shape object with
diameter of 0.15 mm

OK | Cancel| Help|

* The scale can be set by
changing the Known distance
and Unit of length in Set Scale
menu according to the
calibration scale




Other Data Collection

From the data collected in previous slides, we are able to calculate data
as presented below

A B C D E F G H I ] K L
EDV ESV ; , | StrokeVolume Stroke Volume Heartrate  Cardiac Ejection Shortening
Long Axis (um) Short Axis (um) Long Axis (um)  Short Axis {pm) EDV (um)  ESV (um) (um*/beat) (pL/beat) (BEM) Output Fraction (%)  Fraction (%)
171.5033578 93.22773244 45.37291117 121.3720317 1,435,066.72 372,921.88 1,062,144.83 1,062.14 125,14 132,313.84 74.01 29.23

A, B, C, and D are data collected from slide 31 and 32
E and F are End Diastolic Volume and End Systolic Volume respectively with the equation :

1 : :
S XTX Long Axis x Short Axis?

Assuming the heart is spheroid in shape with missing axis having the same length as the short axis.
G and H are Stroke Volume = EDV — ESV

| is the Heart rate calculated using Microsoft excel

J is the Cardiac Output = Stroke Volume x Heart rate, as it shows the volume of blood pumped within a minute
K Ejection Fraction is percent heart volume changes during diastole and systole

Eiection Fraction = 220 — B3V 1009
]€C lon rraction = EDV X 0

L Shortening Fraction is percent heart short axis changes during diastole and systole according to
EDV Short Axis — ESV Short Axis

Ejection Fraction = 1009
jection Fraction EDV Short Axis X Yo




Installation of Imagel) macro

* Add the macro to the ImagelJ > Plugin > Macros folder.

* Open Imagel then install the macro (Plugins > Macros > Install...) by
locating the macro in previous Macros folder.

Macros ' Install... I

Shortcuts | Run. l | £ Install Macros *
Utilities v Edit . [ led% | Macros j &% Ev
New »| Startup Macros... - N
. . I Mame Date modified T
Compile and Run... Interactive Interpreter... Ctrl+J 537
Install._.. Ctrl+Shift+M | Record... Quick access
install Plugin... Open/Create Project m
B Py Analyze Skeleton Desktop | kymograph macro.bet 28-Aug-202:27 PM
Actogram.J Edit Time Intervals
™
Analyze *|  Analyze Flow Libraries
BestEdges * | Produce Spatial Map LJ
BigDataViewer v
. This PC
Bio-Formats 4
Cluster v L\]‘
Caolor Inspector 3D S Network
{Fiji Is Just) Imagel Debayer N * < >
File Edit Image Process Analyze B > |
P File name: |k:.'mogra|:uh macro tst ﬂ Open
0 o|c|ol /)4 +|\AJQM s = [ O |
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Macro

Our macro was made to help users in obtaining the data.
These are the command strings contained in the kymograph macro.txt

The first macro is to make kymograph using Image) Dynamic Reslice and rotating the kymograph by
90 degrees This macro is bound to F2 key on user’s keyboard, which can be modified by changing it
to the user’s preference.

macro "Make Kymograph [F2]" {

run("
Dynamic Reslice",

}

rotate");



Macro

The second macro is to enable users’ to use smoothed plot by creating a new plot
based on the plot made by the BAR Plugin. This macro is bound to F3 key

macro "Smoothed Plot [F3]" {
run("Smoothed Plot Profile", "window=4 pixelunits=true");
waitForUser("Adjust ROl location on Kymograph, Select Plot Window, Then Click OK");
Plot.showValues("Plot Values");
x1 = Table.getColumn("X0");
Y1 = Table.getColumn("Y1");
xValues = x1;
yValues = Y1,
Plot.create("Smoothed Plot", "X", "Y", xValues, yValues);
Plot.setLineWidth(1);
Plot.show();



Macro

The third macro is to run Find Peaks, bound to F4 key.
macro "Find Peaks [F4]" {

run("Find Peaks");



Macro

The last macro is to close all windows made during data gathering in
Imagel, bound to F5 key.

macro "Close All Windows [F5]" {
while (nImages>0) {
selectimage(nimages);
close();



